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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

 

Intended Audience 

This User Guide is intended for the following audience: 

 Persons in charge of introducing automation devices. 

 Persons who design automation systems. 

 Persons who install or connect automation devices. 

 Persons who manage working automation installation. 

 

 

 

 

 

  Warnings: 

 Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

 Improper use of this product may severely damage the controller. 

 Refer to the controller’s User Guide regarding wiring considerations. 

 Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

 Systems, machines, and equipment that could present a risk to life or property. 

 Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

 Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESS 

OR IMPLIED, REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR 

FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. ANY BUYER OR 

USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE HAS DETERMINED 

THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR 

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, 

EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 

 

 

 

 

 

 

 

 



       
P

ag
e8

 

Table of Contents 
Preface…………………………………………………………………………………........................................... 4 

1. Ardbox Analog HF: General Features .......................................................................... 9 

2. Precautions ............................................................................................................... 10 

 Arduino Board ................................................................................................... 10 

 Intended Audience ............................................................................................ 10 

 General Precautions .......................................................................................... 10 

3. Technical Specifications ............................................................................................ 11 

 General Specifications: ...................................................................................... 11 

 Performance Specification: ............................................................................... 11 

4. Software interface ..................................................................................................... 12 

5. How to connect PLC Arduino to PC ........................................................................... 15 

6. How to connect PLC to power supply ....................................................................... 16 

Din RAIL Power Supply, ac-dc, 30W, 1 Output 1.3A at 24Vdc .......................................... 17 

1. Din RAIL Power Supply, ac-dc, 30W, 1 Output 1.3A at 24Vdc .................................. 17 

7. Ardbox Analog I/O pinout: ........................................................................................ 17 

 Zone Connections .............................................................................................. 17 

8. Switch configuration ................................................................................................. 19 

 General Switches Configuration ........................................................................ 19 

 RS- 485 Switch configuration ............................................................................ 21 

 RS-232 Switch configuration ............................................................................. 21 

 I2C Switch configuration ................................................................................... 22 

9. Jumper Configuration................................................................................................ 22 

General Jumper Configuration .......................................................................................... 22 

10. Hardware Serial RS-232 & RS-485 Configuration ...................................................... 23 

 Hardware Serial RS-485 ..................................................................................... 23 

 Hardware Serial RS-232 ..................................................................................... 24 

11. Ardbox - Arduino  I/Os 5V pins .................................................................................. 25 

 I2C pins – SDA/SCL ............................................................................................ 26 

 SPI – MISO/MOSI/SCK ....................................................................................... 26 

12. I/0 technical details ................................................................................................... 26 

13. Typical Connections .................................................................................................. 29 

14. Connector details ...................................................................................................... 33 

15. ARDBOX Family Dimensions:..................................................................................... 34 

16. DIN rail mounting: ..................................................................................................... 34 

file:///F:/Dropbox%20(Boot&Work_Corp_SL)/Equipo%20Tecnico/PROYECTOS/INDUSTRIAL%20SHIELDS/I+D/Documentacion%20equipos%20USUARIO/User%20Guides%20Equipments%20-%20All%20versions/20IOs%20PLC/Analog/Ardbox%20Analog%20HF%20232-485/26-11-2018/Ardbox%20Analog%20HF%20User%20Guide.docx%23_Toc531077434
file:///F:/Dropbox%20(Boot&Work_Corp_SL)/Equipo%20Tecnico/PROYECTOS/INDUSTRIAL%20SHIELDS/I+D/Documentacion%20equipos%20USUARIO/User%20Guides%20Equipments%20-%20All%20versions/20IOs%20PLC/Analog/Ardbox%20Analog%20HF%20232-485/26-11-2018/Ardbox%20Analog%20HF%20User%20Guide.docx%23_Toc531077435


       
P

ag
e9

 

1. Ardbox Analog HF: General Features 

A compact PLC based in Open Source Hardware technology. With different 

Input/Outputs Units. 

 

 

 

 

 

 

COMPACT PLC ARDUINO ARDBOX 20I/Os 
ANALOG HF 

 

Supply Voltage 12 to 24Vdc 
Fuse protection (2.5A) 

Polarity protection 
 

Max. current consumption 1,5A  

Size 100x45x115  

Clock Speed 16MHz  

Flash Memory 
32KB of which 4KB are used by 

bootloader 
 

SRAM 2.5KB  

EEPROM 1KB  

Communications 
I2C -- USB -- RS232 -- RS485 -- 

SPI -- TTL  
RS485  

TOTAL Input points 10  

TOTAL Output points 10  

INPUTS 

 
Digital range:12 to 24 Vdc (7.6 to 

25.4 Vdc) 
 

Analog range: 0 to 10 Vdc 
 

 

Digital 10 

 
7 to 24Vdc 

I min: 3/6 mA 
Separated PCB ground 

 

Analog 10 bits  6  

 
0 to 10V 

Input Impedance: 39K 
Separated PCB ground 

 

* Interrupt HS  1  

 
7 to 24Vdc 

I min: 5/10 mA 
Separated PCB ground 

 

OUTPUTS 

 
Digital Isolated range: 5 to 24 Vdc 

(4.6 to 25.4 Vdc) 
 

Analog range: 0 to 10 Vdc 
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2. Precautions 

 Arduino Board 

All Ardbox family PLCs include Arduino LEONARDO board.  

 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 

The user must operate the product according to the performance specifications 

described in the operation manuals. 

Before using the product under conditions, which are not described in the manual or 

applying the product to nuclear control systems, railroad systems, aviation systems, 

vehicles, combustion systems, medical equipment, amusement machines, safety 

equipment and other systems, machines, and equipment that may have a serious 

influence on lives and property if used improperly, consult your INDUSTRIAL SHIELDS 

representative. 

Make sure that the rating and performance characteristics of the product are sufficient 

for the systems, machines, and equipment, and be sure to provide the systems, 

machines, and equipment with double safety mechanisms. 

This manual provides information for programming and operating the Unit. Be sure to 

read this manual before attempting to use the Unit. Keep this manual close at hand for 

reference during operation. 

 

Digital Isolated 10 

 
5 to 24 Vdc 

I max: 70 mA 
Galvanic INSULATION 

Diode Protected for Relay 
 

Analog 8 bits  7 

 
0 to 10 Vdc  

I max: 20 mA 
Separated PCB ground 

 

PWM Isolated 8bit 6 of 10 Digital isolated Output 

 
5 to 24 Vdc 

I max: 70 mA 
Galvanic INSULATION 

Diode Protected for Relay 
 

Expandability I2C – RS232 – RS485 – SPI – TTL  

Reference 
IS.AB20ANA.HF 
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3. Technical Specifications 

 General Specifications: 

Power supply 
voltage 

DC power supply    12 to 24Vdc 

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply voltage 12 to 24Vdc 

Power supply output 
capacity 

1.3A 

Insulation resistance 
20MΩ min. at 500Vdc between the AC terminals and the protective ground 
terminal. 

Dielectric strength 
2.300 VAC at 50 to 60 Hz for one minute with a leakage current of 10mA 
max. Between all the external AC terminals and the protective earth 
terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 45ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 
340g max. 

 

 

 Performance Specification: 

Arduino Board ARDUINO LEONARDO 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform 
composed of a programming language. “similar to the C”. 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega32u4 

Flash Memory 32KB of which 4KB are used by bootloader 

Program capacity (SRAM) 2.5KB 

EEPROM 1KB 

Clock Speed 16MHz 

http://arduino.cc/en/Tutorial/HomePage
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4. Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Furthermore Industrial Shields provides boards for programming the PLCs much easier. 

Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is 

set up automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager 

 

 

5. Search for industrialshields on the searcher. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following this steps you will be able to use now the Industrial Shields Boards: 
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Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 

 

 

Also there are some examples of programming in File -> Examples -> Ardbox Family. 

Furthermore there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

https://github.com/IndustrialShields/
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5. How to connect PLC Arduino to PC 

 

- Connect USB port from PLC to PC. 

NOTE:  
Ardbox Family uses micro USB cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> Ardbox Family 
 

- Select the correct Ardbox Analog Board. 
 

 
 

If it is used the latest version of Industrial Shields boards it will appear 4 different Ardbox 
Analog boards: 
 
The ones that have to be used for the 103-002-72 Ardbox Analog HF are the following ones: 
 

 Ardbox Analog HF w/ HW RS-485 

 Ardbox Analog HF w/ HW RS-232 
 

* HW is the abbreviation of Hardware, so depending on the Hardware Serial that will be used, 
it is needed to select one or the other. See section 10 to configure the equipment to work with 
RS-232 Hardware Serial or RS-485 Hardware Serial.  
If it is not used the RS-232 & RS-485 it is needed to select the board Ardbox Analog HF w/ HW 
RS-485. See section 8 to enable the features that are disabled when using RS-485 protocol that 
will get enabled as there is no RS-485/RS-232 protocol. 
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- Select correct port. 

 

 

 

Now everything is set up to upload a sketch to Ardbox Relay HF 

6. How to connect PLC to power supply 

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 
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- Suggested power suppliers

  

 

7. Ardbox Analog I/O pinout: 

 Zone Connections 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 See section 8 to enable these connections 

2 See section 9 to enable these connections 

 

LEFT ZONE 

A
rd

b
o

x
  

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
 

A0.61 
A0.51 
A0.41 
A0.31 
A0.21 
A0.11 
A0.01 

 
Q0.92 
Q0.82 
Q0.7 
Q0.61 
Q0.5 
Q0.4 
Q0.3 
Q0.2 
Q0.1 
Q0.0 

 

GNDCOM 
24VCOM 

3 
5 
6 
9 
10 
11 

13 
 
4 
8 
12 
3 
5 
6 
9 
10 
11 
13 
 

- 
- 

Analog Out 
Analog Out 
Analog Out 
Analog Out 
Analog Out 
Analog Out 
Analog Out   

 
Digital Output  
Digital Output  
Digital Output 

PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 

 

Isolated GND 
Isolated VIN 

* Not recommended for industrial applications. The 

Jack connector needs to be removed and use the live 

and GND connectors.   

1. Din RAIL 

Power 

Supply, ac-dc, 

30W, 1 

Output 1.3A 

at 24Vdc 

 

Din RAIL Power Supply, ac-dc, 

30W, 1 Output 1.3A at 24Vdc 
 

LEFT ZONE 
 
 
 
 
 
Switch config*  
(see section 8 for Communications  
configuration. Enabling Communications  
disables some  I/Os) 
  

 

 

Analog Outputs pins 
 

 

 

Digital Outputs pins 

 
 
 
Power supply connectors  
(24Vdc – GND) 
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HS*: Hardware Serial 
SS*: Software Serial 
 

1  See section 8 to enable these connections 
2  See section 9 to enable these connections 

 

NOTE: Although in the serigraphy it is not shown the RS232 communication pins, in the reality 

it exists. The change that has to be done is the following: 

DEFAULT SERIGRAPHY CORRECT SERIGRAPHY 

SDA-PIN2 SDA-PIN2 

NC TX-RS232 

NC RX-RS232 

GND GND 

 

 

 

 

 

RIGHT ZONE 

A
rd

b
o

x
  

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

R
S

2
3
2
 H

S
* 

A
rd

u
in

o
 P

in
 

R
S

4
8
5
 H

S
* 

F
u

n
c
ti
o

n
 

A+1,2 
B-1,2 
Y+1,2 
Z-1,2 

SCL-PIN31 
SDA-PIN21 
TX-RS2321,2 
RX-RS2321,2 

5V 
RESET 

SCK 
MOSI 
MISO 
I0.9 
I0.8 
I0.7 
I0.6 
I0.5 
I0.4 
I0.31 
I0.21 
I0.1 
I0.01 

- 
- 
- 
- 
3 
2 
0 
1 
- 
- 
- 

- 
- 

18 
19 
20 
21 
22 
23 
0 
1  
7 
2 

- 
- 
- 
- 
3 
2 
4 
8 
- 
- 
- 
- 
- 
18 
19 
20 
21 
22 
23 
0  
1 
7 
2 
 

RS485(A) 
RS485(B) 
RS485(Y) 
RS485(Z) 
SCL(I2C) 
SDA(I2C) 

- 
- 

5Vout DC 
RESET 

SPI 
SPI 
SPI 

Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Digital Input 
Digital Input 
Digital Input 

Digital interrupt 

                                                               Input / Output              Power LED          Arduino Reset  

                                                                                                                                             button 

                                                                          

                 

 

LEFT ZONE 
 
 
 
 
 
Switch config*  
(see section 8 for Communications  
configuration. Enabling Communications  
disables some  I/Os) 
  

 

 

 

 

 

Communications pins 
 

 

 

Digital/Analog Inputs 

 
 
 

 

Config switch * 
(see section 8 for communications 
configuration) 
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NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they 

are I0.3 I0.2 pins respectively. Additionally although the serigraphy only is expressed for the 

RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial 

connection this is the function of these switches. See chapter 8 for more information 

  

 

 

8. Switch configuration 

 General Switches Configuration 

LEFT ZONE. 

Communications and inputs/outputs can not work simultaneously. 
 

                        

 

 

 

 

*I2C switch serigraphy is turned around. It should be: (SDA-D2 , SCL-D3). RX-RS485 should be RE-RS485 

6. DE-RS485 – If this switch is ON, the A0.2-Q0.2 switch must be set to OFF. Being in ON mode 

it enables DE for the RS-485. 

5. A0.2-Q0.2 – If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode 

it enables the outputs A0.2-Q0.2. 

4. RE-RS485 – If this switch is ON, the A0.1-Q0.1 switch must be set to OFF. Being in ON mode 

it enables EE for the RS-485. 

3. A0.1-Q0.1 – If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode 

it enables the outputs A0.1-Q0.1. 

2. SDA-D2/I0.0 – Choosing between SDA (I2C) and I0.0. If this switch is ON, the I0.0 input will 

be enabled and the SDA will be disabled. If this switch is OFF, the SDA will be now available 

and I0.0 disabled 

1. SCL-D3/Q0.6 – Choosing between SCL (I2C) and Q0.6. If this switch is ON, the Q0.6 input will 

be enabled and the SCL will be disabled. If this switch is OFF, the SCL will be now available and 

Q0.6 disabled. 

I0.3 RS485/RS232 HS I0.2 RS485/RS232 HS 

LEFT ZONE 

SWITCH OFF ON 

DE-RS485 A0.2-Q0.2* DE-RS485 

D10/A0.2-Q0.2 DE-RS485 A0.2-Q0.2 

RE-RS485* A0.1-Q0.1* RE-RS485 

D11/A0.1-Q0.1 RE-RS485 A0.1-Q0.1* 

SDA-D2/I0.0* SDA-D2 I0.0 

SCL-D3/Q0.6* SCL-D3 Q0.6 
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TOP ZONE. 

 

 

 

 

 

NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they 

are I0.3 I0.2 pins respectively. Additionally although the serigraphy only is expressed for the 

RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial 

connection this is the function of these switches. See chapter 8 for more information 

  

 

 

1. I0.3: If this switch is ON, the RS485/RS232 HS switch must be set to OFF. Being in ON 

mode it enables I0.3. 

2. RS485/RS232 HS: If this switch is ON, the I0.3 switch must be set to OFF. Being in ON 

mode it enables the D0 for the RS-485 or RS-232 Hardware Serial (see section 9 for 

jumper configuration) 

3. I0.2: If this switch is ON, the RS485 switch must be set to OFF. Being in ON mode it 

enables I0.2. 

4. RS485/RS232 HS: If this switch is ON, the I0.2 switch must be set to OFF. Being in ON 

mode it enables the D1 for the RS485 or RS-232 Hardware Serial (see section 9 for 

jumper configuration) 

RIGHT ZONE 

 

 

 
 
 
 
 
 
 

 

RIGHT ZONE. The right zone configures the outputs. If the switch is set to “ON” the Q0.X will 
have the behaviour of a digital output. If it is set to “OFF” it will be analog. There is also a switch 
for switching between Half and Full Duplex. It is “ON” for Half Duplex and “OFF” for Full Duplex. 
 

TOP ZONE 

SWITCH OFF ON 

I0.3 RS485/RS232 HS I0.3 

RS485/RS232 HS I0.3 RS485/RS232 HS 

I0.2 RS485/RS232 HS I0.2 

RS485/RS232 HS I0.2 RS485/RS232 HS 

I0.3 RS485/RS232 HS I0.2 RS485/RS232 HS 

RIGHT ZONE 

SWITCH OFF ON 

H/F Full Duplex Half Duplex 

Q0.6 ANALOG (A0.6) DIGITAL (Q0.6) 

Q0.5 ANALOG (A0.5) DIGITAL (Q0.5) 

Q0.4 ANALOG (A0.4) DIGITAL (Q0.4) 

Q0.3 ANALOG (A0.3) DIGITAL (Q0.3) 

Q0.2 ANALOG (A0.2) DIGITAL (Q0.2) 

Q0.1 ANALOG (A0.1) DIGITAL (Q0.1) 

Q0.0 ANALOG (A0.0) DIGITAL (Q0.0) 
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 RS- 485 Switch configuration 

 

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE 
must be configured as it is shown in the table. 
Although the switch serigraphy is only referenced to RS-485 it is also the 
for the RS-232. 
 
Having this setup, the I0.3 & I0.2 are disabled 
 
 

 
 
 

RS-485 LEFT ZONE: In order to enable the RS-485 communication 

protocol it is necessary that the switches of the left zone are 

configured as it is showed in the table. 

The ones marked with “-“ mean that they don’t affect the RS-485 

communication protocol 

 

 

 

 

 RS-232 Switch configuration 

RS-232 TOP ZONE: In order to enable the RS-232 communication protocol it 

is necessary that the switches of the top zone are configured as it is shown in 

the table. 

Although the nomenclature is not referenced to the RS-232, this switches 

relates the hardware serial of the Arduino board.  

 

RS-232 LEFT ZONE: In order to enable the RS-232 communication protocol 

it is necessary that the switches of the left zone is configured as it is 

showed in the table. 

The ones marked with “-“ mean that it does not affect the RS-232 

communication protocol 

 

 

TOP ZONE 

SWITCH MODE 

I0.3 OFF 

RS485 HS ON 

I0.2 OFF 

RS485 HS ON 

LEFT ZONE 

SWITCH CONFIGURATION 

SWITCH MODE 

DE-RS485 ON 

D10/A0.2-Q0.2 OFF 

RE-RS485 ON 

D11/A0.1-Q0.1 OFF 

SDA-D2/I0.0 - 

SCL-D3/Q0.6 - 

TOP ZONE 

SWITCH MODE 

I0.3 OFF 

RS232 HS ON 

I0.2 OFF 

RS232 HS ON 

LEFT ZONE 

SWITCH MODE 

DE-RS485 OFF 

D10/A0.2-Q0.2 ON 

RE-RS485 OFF 

D11/A0.1-Q0.1 ON 

SDA-D2/I0.0 - 

SCL-D3/Q0.6 - 
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 I2C Switch configuration 

 

 

 
 
 
 
 

 
 
 
 

I2C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. I0.0 

and Q0.6 will not be available. In order to implement this communication a 4.7kΩ pull-up 

resistor (IS.ACI2C-4.7K) is required. 

9. Jumper Configuration 

General Jumper Configuration 

This jumper makes the choosing between connecting MAX232 to pins 
0,1 of the Arduino Leonardo or with the MAX485. In order to use the 
RS-232 Hardware Serial protocol both RS-232 must be connected to the 
D1/D0. In order to use the RS-485 Hardware Serial protocol both   
RS-485 must be connected to the D1/D0. 
 
 
This jumper zone makes the choosing between connecting the inputs 
I0.2, I0.3 to pins 4 and 8 of the Arduino Leonardo respectively, or 
connect the RS-232 ports to activate the Software Serial RS-232. In 
order to use the inputs I0.2,I0.3 the jumper must be connected to the 
pins 4 and 8. So I0.2 must be connected with D4 and I0.3 must be 
connected to D8. 
 

 
*The jumpers that are not connected to the middle jumpers MUST NOT be Connected anywhere. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

TOP ZONE 

SWITCH MODE 

I0.3 - 

RS485/RS232 HS - 

I0.2 - 

RS485/RS232 HS - 

LEFT ZONE 

SWITCH MODE 

DE-RS485 - 

D10/A0.2-Q0.2 - 

RE-RS485 - 

D11/A0.1-Q0.1 - 

SDA-D2/I0.0 OFF 

SCL-D3/Q0.6 OFF 

JUMPER ZONE 1 

 LEFT RIGHT 

RS-485 RS-485 

D0 D1 

RS-232 RS-232 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

RS-232 SS RS-232 SS 

http://www.industrialshields.com/Industrial%20Pull%20UP%20I2C%20connection


       
P

ag
e2

3
 

 
 
 

 
 
 
 

10. Hardware Serial RS-232 & RS-485 Configuration  

 Hardware Serial RS-485 

Switch configuration: 

 

 

 

 

 

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF 

will be: 

LEFT ZONE 

SWITCH MODE 

DE-RS485 ON 

D10/A0.2-Q0.2 OFF 

RE-RS485 ON 

D11/A0.1-Q0.1 OFF 

SDA-D2/I0.0 - 

SCL-D3/Q0.6 - 

TOP ZONE 

SWITCH MODE 

I0.3 OFF 

RS485 HS ON 

I0.2 OFF 

RS485 HS ON 
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Jumper configuration:  

 

  

 

 

Having configured Ardbox Analog HF as it is shown above, these are the features that are 

available: 

o Available communication protocols: 

 Hardware Serial RS-485. 

 I2C  *If I2C is active I0.0 & Q0.6 are disabled 

 SPI 

 TTL 

 USB 

 

o Inputs: 8 out of 10 inputs, I0.0, I0.1 and 10.4 to I0.9. If using I2C I0.0 is also disabled 

o Digital Outputs: All 10 outputs. If using I2C Q0.6 is disabled.  

o Analog Outputs: From A0.0 to A0.6. If using I2C A0.6 is disabled 

 

 Hardware Serial RS-232 

 

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF 

will be: 

 

Switch configuration: 

 

 

 

 

 

 

 

JUMPER ZONE 1 

 LEFT RIGHT 

RS-485 RS-485 

D0 D1 

- - 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

- - 

LEFT ZONE 

SWITCH MODE 

DE-RS485 OFF 

D10/A0.2-Q0.2 ON 

RE-RS485 OFF 

D11/A0.1-Q0.1 ON 

SDA-D2/I0.0 - 

SCL-D3/Q0.6 - 

TOP ZONE 

SWITCH MODE 

I0.3 OFF 

RS232 HS ON 

I0.2 OFF 

RS232 HS ON 

Note: The switches of the left 

zone of the RS-485 don’t 

interfere in the RS-232 HS, the 

thing is that as pins 0 & 1 are 

reserved for the RS-232, the 

RS-485 is totally disabled. As it 

is disabled, there is no point on 

configuring these switches as 

RS-485 mode 
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Jumper configuration:  

 

  

 

 

 

 

o Available communication protocols: 

 Hardware Serial RS-232. 

 I2C  *If I2C is active I0.0 & Q0.6 are disabled 

 SPI 

 TTL 

 USB 

 

o Inputs: 8 out of 10 inputs, I0.0, I0.1 and 10.4 to I0.9. If using I2C I0.0 is also disabled 

o Digital Outputs: All 10 outputs. If using I2C Q0.6 is disabled.  

o Analog Outputs: From A0.0 to A0.6. If using I2C A0.6 is disabled 

 

11. Ardbox - Arduino  I/Os 5V pins 

The Ardbox has some of the Mega board pins available.  These pins can be programmed 

according to Arduino features such as I/Os operating at 5V or any additional features present 

in the pins (for example I2C communication in pins SCL and SDA). As this pins are directly 

connected to the Arduino Mega board they are not as well protect as the normal inputs. These 

pins are mainly meant to be used as prototyping. 

 

 

 

 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Mega board. 

A part from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

JUMPER ZONE 1 HALF DUPLEX 

 LEFT RIGHT 

- - 

D0 D1 

RS-232 RS-232 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

- - 

M-Duino terminal Arduino pin 

SCL – Pin 3 3 

SDA – Pin 2 2 

MISO 14 

SCK 15 

MOSI 16 



       
P

ag
e2

6
 

 I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino 

Leonardo are not pull-up, so in order to work with the I2C an external pull-up resistor is 

required. If it is meant to work as a GPIO at 5V, the switches must be set as I2C, (section 8).  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 SPI – MISO/MOSI/SCK 

These pins can only work as a 5V pins. As the Ardbox family does not implement the Ethernet 

protocol, these pins can always work as a 5V pins. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 

 

 

12. I/0 technical details 

Digital Output Waveform 

 

 

 

 

 

 

 

Digital Output Turn-off 
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PWM Waveform 

 

 
Analog Out Turn-on 
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Analog Out Turn-off 

 

 
Analog/Digital Input Turn-on 

 

 
Analog/Digital Input Turn-off 
 

 

 

 

 



       
P

ag
e2

9
 

13. Typical Connections 
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14. Connector details 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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15. ARDBOX Family Dimensions: 

16. DIN rail mounting: 

17.  

 

  

 

45mm width 
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About Industrial Shields: 
 
Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 

mailto:industrialshields@industrialshields.com

